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 What's New...
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1.1  Workflow Documents





Download: Click Here




Download: Click Here




Download: Click Here




Download: Click Here




Download: Click Here



2 of 140



1.2  ScanStudio and RapidWorks Webinars



>Advanced Mesh Processing In RapidWorks
          Download: Webinar
Video / Sample Files
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1.3  QA-Scan 3.0.0
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1.4  RapidWorks 3.5.1
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1.5  RapidWorks 3.5.0
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1.6  QA-Scan 4.0
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1.7  RapidWorks 4.1
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1.8  RapidWorks 4.0
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1.9  MultiDrive



>Setup

> MULTIDRIVE SETUP 

-Here are the items that are included with the
MultiDrive



Allen wrench L Bracket AutoPostioner


-Attach the L Bracket to the MultiDrive with two flat head screws and allen
wrench




-Attach the MultiDrive to the bottom of the scanner and fasten a screw
underneath the scanner for additional stability




-Plug in the MultiDrive to the scanner
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-Start ScanStudioHD and proceed to Calibration


>Calibration

>CALIBRATING THE MULTIDRIVE



Starting first scan with


-"Start" to begin the automated calibration process (We suggesting using the
palm tree included with the MultiDrive)
-"Skip" if you wish to proceed to
the scan panel and choose 
-"Learn More" to be directed to this help
page.



You can


-This function is available for re-calibration when alignment results in an error
or when the MultiDrive was detached and is reattached.


>Scan Process

>SCANNING PROCESS



After calibration is
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A new scan panel will be


-Five families are now available for predefined settings for Positioning,
Divisions, Start Angle, Tilt Angle, Points/IN^2 and Target 
-Clicking on
the family name will enable the tab to edit the settings.
-To enable or
disable a family, simply check or uncheck the circle next to the family
name.
-Starting positions can be set for both the initial and tilt axis by
moving the slider bar arrow.
-The start axis has the full 360 rotation and
tilt axis is bounded to -35 to 45 degrees.
-Use the top slider bars to
visually set the starting and tilt positions. (This will update the settings for
the scan family)




-Select the scan settings for each tab and check the tabs you want to have
scan. 
If the setting for a tab have been adjusted, but the tab is not
checked it will not scan.
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-All MultiDrive scans are to be in MACRO mode.
-Select a ROI for your
model to prevent the MultiDrive from being scanned in for certain tilt angles.
-
If additional scans are needed, enter scan panel and position the model by
using different starting and tilt angles to capture additional scans. 
-If you
physically adjust the part, then a 3 pin alignment will be needed to align.
-
When finished, trim unnecessary data and "Fuse" or "Volume Merge" the
model for export: ->


>Troubleshooting

b>Switching between AutoDrive and MultiDrive 
- Simply plug in an AutoDrive
to display the proper UI. 
- When reattaching the MultiDrive, make sure to
recalibrate as needed.

- When more than 5 Scan families are required, then
just click on scan to enter the scan panel, and you can add 5 more new
sessions. These scans should auto align to the previous scans assuming all the
movement and rotations were done by the turntable. If they don't auto-align
, just drag the scans into the green and refine (no pins required)

- Force
Calibration. If your scans are not coming in aligned, you may need to run a
force calibration. You can do this from the drop down menu , Align, then
go down to Calibrate MultiDrive


>Dental

>DENTAL

Recommended Scan Settings for Dental Cast Models
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Family A Divisions: 6 

Family B Divisions: 6 


-Use the HD speed for higher resolution
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1.10  ScanStudio HD 1.3.2
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1.11  QA-Scan




>Proven Accuracy, Super Speed and Huge Data Capacity
When it comes to
inspection, every calculation counts. That's why QA Scan's geometry
calculation algorithms have been tested by America's NIST, Britian's NPL and
independently certified by Germany's PTB metrology authority as Class 1
accuracy. Top manufacturers around the world trust QA Scan to measure
thousands of parts every day.
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Chapter 2



 Installation
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2.1  System Requirements



>PC


The 3D Scanner HD is a high resolution device, and quickly captures many
millions of points and pixels.  A powerful PC is key for being able to
visualize and take full advantage of this data.




Note:
If you are going to be scanning large or complex models, we highly
recommend running a 64bit OS and upgrading your RAM to at least 4
GB.

For a fast viewing experience, a good graphics card is essential.  In
our testing we've found that not all GPU's are optimized for dealing with lots
of points and pixels.

Quick tip for a new Graphics Card:  The latest and
greatest is the nVidia GeForce GTS/GTX series. They are well priced and can
handle large amounts of scan data smoothly. The GeForce GTS/GTX series is
available on Newegg with a price range of $115 to $300.

High-end
systems need sufficient power to run properly.  If you are seeing errors in
ScanStudio HD, it maybe related to an under specified power supply.  A
600+ watt power supply is recommended to run high-end systems like those
with Intel Core i7 processors.

If you have questions about your system
configuration, we'd be happy to help.  Please note the SD scanner is only
compatible with Windows XP and Vista when you are running as the
administrator. All software developed after ScanStudio CORE is only for HD
scanners. If you would like to upgrade your SD scanner please contact
NextEngine at info@nextengine.com.

Please click "Ask?" to talk to us about
it.


>USB


The scanner requires a USB 2.0 connection.

Here's how to check if
you have USB 2.0 support, which is required to run the Desktop 3D
Scanner.
- Right-click My Computer
- Click on Properties
- Click on the
Hardware tab
- Click on the device Manager button




- Scroll down as needed until you see Universal Serial Bus Controllers
-
Expand that by clicking on the boxed plus sign in front of Universal Serial Bus
Controllers
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If it says "Standard Enhanced PCI to USB Host Controller" it is 2.0. If
it does not say "Enhanced" it's USB 1.0.


>PC Buying Guide


It's now possible to purchase a PC with great scanning, CAD, and graphics
performance for under $1000.

We've found that the best combo in terms
of price / performance is to assemble the computer from scratch, purchasing
individual parts. For a ready made PC, options such as Dell and HP will let
you choose individual components to meet your needs.

Some tips are provided
below for finding the best deals (as of November 2009).  We don't
have a relationship with any of these vendors, but this is how we buy most
of our test hardware.

Go to Newegg.com and check out their latest deals. 


Look for a Intel Core2 Quad Processor.  These are the some of the best
processors currently available, and are dropping in price significantly.  

  
Intel Core2 Quad Q9400 - 2.66GHz 6MB L2 Cache - LGA 775
95W 
   Price: $190
  
http://www.newegg.com/Product/Product.aspx?Item=N82E16819115131



Upgrading the RAM:

For stable performance when capturing complete
models, 4 GB of RAM is recommended.  One example:

   4 GB
DDR2 PC2-8500 RAM 
   Price: $89
  
http://www.newegg.com/Product/Product.aspx?Item=N82E16820231166&
cm_sp=DailyDeal-_-20-231-166-_-Product



Upgrading the Graphics
Card:

We've found that the nVidia GeForce GTS/GTX series are well priced
and can handle large amounts of scan data.  We've also found that
SolidWorks and other CAD programs work quite well with these cards. 
Here's a well priced sample from Newegg.com

   nVidia GeForce GTS
250 - 1GB of RAM 
   Price: $150 
  
http://www.newegg.com/Product/Product.aspx?Item=N82E16814150439


  **Make sure to download the latest driver for your Operating
System**

The ATI FireGL cards are also recommended.  They have great
price/performance.   We do not typically recommend purchasing a nVidia
Quadro for this application.  This is because only the high-end Quadro models
have sufficient processing power to handle large numbers of 3D vertices.


>Supported Operating Systems


ScanStudio HD 1.3.2 runs on Windows x32 and x64 operating systems,
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including Windows XP, Windows Vista, Windows 7 (x32 & x64), and
Windows 8 (x32 & x64).

ScanStudio HD 1.3.2 offers a full 64
bit application.

ScanStudio CORE with the SD scanner is only compatible with
Windows XP, Vista (with administrator rights) as well as Windows 7 (x32
& x64), and Windows 8 (x32 & x64) under special installation
instructions.

Installation instructions for ScanStudio CORE with Windows 7 or
8 (x32 & x64) can be found here: 

        32-bit: ->
 
      64-bit: ->
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2.2  Software Installation



>Download


Please uninstall 1.7.3 before installing ScanStudio HD.

- Go the
ScanStudio Quick Start Page at http://www.nextengine.com/start

Link to the
Download for ScanStudio HD 1.3.0 ->



 Enter your e-mail address and password


- You can find your username and password in the order confirmation e-
mail. If you need your account information please e-mail
info@nextengine.com

- Choose to SAVE the file.
After download is
complete, double click the installer file to start Installation.
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Accept the License Agreement

 It is recommended to install

 Every box should be checked
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 Click to Install the Software

The latest version of .net is

 Make sure the scanner is
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  Once Installation is complete


- For an SD scanner and ScanStudio 1.7.3 you will need to be logged
in as an administrator to install and run the software. For HD scanners running
HD 1.1.0 and newer you are required to install as an administrator, but
do not need administrator privledges on the computer to run the software.


>Connect


- Connect the scanner to the computer's USB port




- For XP and Vista a window will appear alerting you that new hardware
has been detected.



 Select option to Install the
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 When the wizard has


- For Windows 7 the drivers should automatically install once you plug in
the scanner.



 The scan

>Online


If you are connected to the internet activation is very simple.



You will be asked to sign-


- If your computer is connected to the internet it should automatically detect
your computer and validate your ScanStudio license.

- Go to Help, About
ScanStudio to see which version of ScanStudio you are running 
- Click on
Support and go to My Software to see your license status.


>Offline
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You do not need an Internet connection to use ScanStudio.



 If your computer is offline you


- Please go to this link http://support.nextengine.com/license/setup.



 Enter in the requested machine

 Your license will be e-


- Transfer the license file to your offline computer via a USB drive.
-
Save the license file on your computer. 
- Click the license file to launch
ScanStudio.


>License

>ScanStudio CAD Tools and HD Pro Licensing:
- CAD Tools and HD PRO
are assigned to a single username and can only be used on one computer per
license.
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 To activate, click where it says OFF and then it will say

> License Transfer Procedure 
- Click on Support inside of the application.

- Go to My Software 
- You need to turn the software OFF on the old
computer before activating it on a new machine.


*If you have a question
about your license please click ASK and someone from technical support will
help you.
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2.3  Hardware Installation



>Scanner


Installing the Scanner:




- Get your USB and power cords out of box




- Plug power cord into outlet and back of scanner




- Plug USB cord into back of scanner and computer USB port




Note: USB 2.0 is required to handle the large volume of 3D data and
images.


>AutoDrive

b>AutoDrive
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>PartGripper




- Screw PartGripper into one of four corner sockets on AutoPositioner




- Tighten Platter on PartGripper




- Rotate Post clockwise (about 6 turns) to tighten PartGripper into
AutoDrive
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>Tripod

>Scanner and Tripod




There is a screw hole on the bottom of the scanner for attaching the scanner
to a tripod




Next Step: Download and install ScanStudio -> or if already installed start
your first scan
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2.4  Customizing ScanStudio HD



>File Management


-Each new scan is named 3D_Scan_## where the ## gets incremented to
ensure a unique filename for each new scan.

-When you capture the first
scan in a model, you can specify the filename by entering it in the yellow
status area in top bar of the Scan Setup Panel:




-A new folder will be created in your scan results directory with the
specified name.  Your SCN and JPEG files will be saved into that folder as
the scan is captured.

-When you do a File-Save As, ScanStudio will save
all of the needed files (SCN, JPEGS, etc.) into the directory you select,
so you should be able to delete the 3D_Scan_## directory once you've done
a File-Save As. 

-File-Save should save your current SCN file wherever it
resides, so it should save into the 3D_Scan_## directory unless you have
performed a SaveAs or named the model at scan time, at which point it
would save into your specified directory.


>Preferences


-The Application Preferences Dialog is available from the Edit-Preferences menu
and can be used to customize ScanStudio to fit your usage



2D Texture Display
-Enable/disable texture loading and display (can be
disabled to save memory). 
-If it is disabled your model will only be
displayed in solid mode.


>Performance
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Click on Performance to select

b>Disable Decimated Point Cloud
- By deafult the decimated point cloud display
is enabled.
- It will intelligently reduced the point cloud for accelerated
responsiveness.
- You can disable this display option here.
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Chapter 3



 Getting Started
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3.1  Setup



>Surface Prep


Prepare dark, shiny or transparent objects using included tools to help the
lasers capture the data.



Paint Pens: Washes off

Powder: Talc


Testing has also shown that a spray powder like Magnaflux Spotcheck SKD-
S2 Developer works well for prepping objects prior to scanning. 
Here is  a
link to the site where you can purchase. Magnaflux Buy Page



Magnaflux Spotcheck


Other spray alternatives such as foot powder spray or white hairspray can be
used as well:
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Foot powder spray

White Hairspray

>White Hairspray Buy Page


>Alignment Prep


It may be helpful prior to scanning to make alignment marks using the
alignment pen. These marks will make it easier to place pins and identify
locations on the object.  Alternatively, the 3D geometry that the Scanner
captures can be used to align scans.
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3.2  Controls



>Mouse Controls



- Right click to zoom.
- Left click to rotate the model.
- Hold down
the left and right buttons together to pan.
- Use the center scroll button to
pan without selecting an area during trim.


>Starting and Stopping


- Click the Start button to run the scan




- Click the Stop button to stop the scan



>NextWiki Support Center


The SUPPORT button will take you to the NextWiki Support Center.



Click on

>Browsing


- Click on the Close button to close a scan before starting a new project




- Click on the Browse button to open a previously saved scan
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3.3  Scan 



>Intro


- Enter the Scan Panel by clicking the Scan button




- Customize your scan name in the yellow toolbar



>There are 3 main types of scans:



Single:
-Single scan of the object from one angle.


>Speed

>Precision:
Choose MACRO or WIDE distance based on object size and desired
resolution



b>ScanStudio CORE
Choose Standard, Quick or Fine scan speed based on
desired scan time and quality



>ScanStudio HD/HD PRO



Macro Reference Table
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Wide/Extended Reference Table

>Tips
- For ScanStudioHD, go to  Scan -> Settings -> Texture Capture
Mode - and choose Monochrome or No Texture Capture for faster scan
speed.




- Choose Fine  or HD Speed for the greatest resolution.
- Choose Quick
Speed to capture data the quickest with lowest resolution (not recommended for
most parts).
- Calibration will occur for every scan family (AutoDrive and
MultiDrive) by default, but can be disabled by checking the box for "Disable
Scan-time AutoAlignment"


>Position

b>Turn/Step Arrows:



>Region of Interest
- Drag the cursor around the object to select a smaller
scan area



>Regenerate

b>Steps:
- Click on Fuse, Re-Generate Scan(s)
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- Select new scan settings for reprocessing



b>Next Step: Remove unwanted areas such as the PartGripper using Trim or
Align your scans to make a complete model -> . For tips on viewing your
scan ->

- If you have any further questions, please click on the Ask?
button.
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3.4  Align



>Intro

>Selecting Scans to Align
- Double click on thumbnail of a family to separate
the family into individual scans



>Alignment Screen



Click on Align to enter


- When you enter Alignment, you'll see a split screen view
- The left
side shows an assembly of scans/families that are already aligned
- The right
side shows the next piece that you're attaching to that assembly



>Thumbnail Bar




- The green side contains scans and families that are already assembled
-
The blue side is for pieces that aren't part of the assembly yet  
- To
break apart or assemble your model, simply drag parts from one side to the
other


>Single Family

>AutoAlign
- By deafult AutoAlignment is enabled and will run for all 360
and bracket scans. 
- To disable AutoAlignment go to Scan ->Settings.
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>Alignment for 360 or Bracket Scans
- Place 1 pin on a common location
between 2 scans within the family.
- Drag the pin to the location or double
click on the point to place the pin.



>Attach Scans
- The yellow status bar will walk you through the process 
-
Click "Attach Scans" to add your scan to the assembly




- Click File > Save after each alignment in order to save pin locations
-
You can detach a scan by dragging it from the green to the blue and then
you can adjust the pin.


>MultiFamily


- Multiple families can be aligned together.

- Place 3 pins on common
locations between the 2 families
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Two pins placed in front

Third pin placed in back

>Attach Scans
- The yellow status bar will walk you through the process 
-
Click "Attach Scans" to add your scan to the assembly



b>Next Step: Once it's all put together, learn how to trim and fuse your
scan data ->


>Align Settings

>Advanced Settings
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b>Fixing a Single Family
-After your single family alignment is complete
(double click on the family if you need to expand it out), then go to
Align, Settings.




-Check the box "Fixed (will not be moved by alignment)" for scans A1-
An. This will lock the individual scans in the family and not be moved with
future alignment.
-If you check the Fixed button for the Family A tab, then
this will lock the entire family in place and not just the individual scans for
that family.



>Fixing Multiple Families
-For multiple families, go to Align, Settings and
check the box "Fixed (will not be moved by alignment)" for the families
that have been sucessfully aligned and wish to be locked in place.
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>Example:
- Starting out with three families (One 360 and two
brackets)
- Attach Family A to Family B (both families are not fixed)
-
Go to Align, Settings and check "Fixed" for Family A and Family B (They
are now locked in position)
- Proceed to attach Family C to A and B.
-
After C is sucessfully aligned, then go to Align, Settings and fix Family C
-
 Repeat for any additional family attached.
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3.5  Trim



>Intro


- Back up your scan file as a different copy unless ScanStudio has not done
so already.



Click the 'Trim'


- Click the cirlce/square/square selector/poly selector button in the toolbar to
select data




- Select the area on the scan to be removed and continue selecting until all
unwanted area is highlighted
- To remove selected area, click on the "Trim"
 button in the toolbar 
- Continue the process until all unwanted area has
been removed



Before Trim After Trim

>Deselecting


- If an area is incorrectly selected it can be deselected before trimming takes
place.
- To deselect an area, click on the "minus sign" in the toolbar,
which will turn the selectors to blue




- Then click on the area to be deselected.
- Click on the "plus sign"
in the toolbar to return the circle/square to red and resume selecting area to
be removed
- Select "undo" under Edit in the toolbar to undo the last
trim. (This will only work if you have Enabled Model Backups)
- You can
also restore trimmed data through Regeneration of your scan found here: ->


>Navigating


- Click on the "pointer button" before zooming or repositioning the object




- Drag object up/down while right clicking to zoom. 
- Drag the object
while holding down both mouse buttons to pan  ->.
- Hold down center
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scroll to rotate object without selecting any areas.


>When to Trim


- You can trim completed individual scans of 360/bracket scans while other
scans are finishing. 
- Before alignment you should not trim away parts of
the object, only parts of the PartGripper.
- After alignment you can trim
overlapping data to improve fusing/merging. 
- Double click on the aligned
family and drag the scan to be trimmed into the blue thumbnail bar



>Next Step: Fuse your scans to remove any remaining overlap -> or align
your scans if needed ->


>AutoTrim


- Auto-trimming automatically detects and removes data that was captured at a
steep angle relative to the line of sight of the scanner. 
- This can be
useful in removing data that may negatively affect alignment or blending.

-
Auto-trimming is available under the Polish menu and should be run before
aligning, fusing or merging multiple scans together.




- With this option selected you can choose the angle for trimming.




If you have any further questions, please click on the Ask? button.
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3.6  Fuse



>Fuse


The Fuse tool Volume Merges, Remeshes, Fills Holes and Simplifies your
aligned scan data.

- Ensure that the data that you would like to fuse is
aligned in the green section of the bottom view bar.



Click Fuse

Choose Simplification Level


- Enter the desired deviation tolerance for any mesh simplification
(decimation)
- 0.00" simplification will not simplify the data
- Increasing
the simplification will simplify your model and make the file size smaller.
- It
will perform intelligent simplification, which keeps more points in detailed areas
and fewer points in larger planes.



Click to enter Settings

b>- It is best to keep this at the default of 0.9. 



Click FUSE
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New family C is created

>Volume Merge

b>To Merge multiple scans into a single mesh:

- Ensure that the scans to
merge are in the green section of the bottom view bar.



Select Volume

b>Adaptive Meshing
- Adaptive Meshing will intelligently reduced the point cloud
of the final merged model.
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New family C is created


The Merge process will not automatically fill holes in the mesh where there is
no scan data.
You can use the Remesh option after a Merge to create a
water-tight mesh (more info: ->).


>Fusing Large Models


- The number of points that can be merged or fused at one time is
dependant on the Computer Specs. 
- To fuse/merge larger models we
recommend these specs:

CPU: 
Dual Core, Quad Core or i7
processor

Memory: 
4+ GB RAM

Graphics Card: 
512+ MB GPU
(Dedicated, non-integrated)

Operating System: 
Windows XP 64
Bit
Windows Vista 64 Bit
Windows 7 64 Bit

You can check the number
of points in your model under File->Model Information.




To reduce the number of points in your model Regenerate your data a higher
simplification level.
See next section for instructions for regenerating.


>Regenerate
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Since the raw scan data is saved at scan-time, you can regenerate the points
at any time with different point-generation settings. These settings have the
same effect as the sliders on the scan setup screen.

Re-Gen is particularly
useful for changing the simplification value after a scan has been
completed.

Steps:



Click Fuse, Re-

Select new settings for


- Higher Simplification values will result in fewer points in the model. 
-
Simplification level of 2 will result in 1/4 of the original data, level 3
will result in 1/9 of original data...
- Simplification can be increased and
decreased at any time without losing original data.
- Restore Trimmed Data:
Choose this option to restore the trimmed data from either a single scan,
family or the entire model.


>Texture Quality

> Tips to improve textures: 

- Ambient lighting- Minimizing the ambient
lighting in the room can help improve textures.

- Object Distance- If you
are repositioning the object make sure to keep the same approximate distance to
reduce color variation.

- Shadows- Try to minimize shadows as much as
possible. Keep in mind the PartGripper can cause shadows. Prior to scanning
you can preview the rotation using the STEP and TURN buttons in the scan
panel. If necessary you can adjust the position of the rotations to reduce
shadows. If you have a single scan with an extreme shadow you can try to
trim out the shadow as long as the data was capture from a different angle.
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3.7  Polish



>Hole Fill


- Enter the Polish panel.




- Select the Fill tool.



Holes are automatically

>Note: Please make sure that when using the Fill tool, you are working with
a fused, merged or a single scan model.

- Use the selector tools to select
the holes that you would like to fill.
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Selected holes will turn


- When you finish your selection(s), select the Fill button to permanantly
commit these triangles into your model.



After Fill

>Auto Hole Fill

To have ScanStudio automatically fill holes in the scan
data:

- Ensure that the data that you would like to fill holes on is a
volume merged model in the green section of the bottom view bar.




- Select the Fill Holes tool from the Advanced Polish Menu.




- Enter desired Hole Filling Settings.
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a. FILL METHOD: 
          - Flat Fill will fill the holes along
a flat edge.  
          - Smooth Fill will fill the holes along a
smooth edge.
          - Curvature Fill will analyze the neighboring
geometry and try to match the overall curvature.
b. MAX VERTICES:
Controls the maximum number of vertices for holes to fill.  Increase to fill
more holes.
c. LEAVE LARGEST: Enable this option to leave the largest
hole in the scans.
d. SMOOTH BOUNDARIES: Enable this option to smooth
the vertices on the edge of the holes as part of the fill process.

You can
also use the Remesh tool to automatically fill holes in merged data: ->
You
can alternatively use the ScanStudio manual hole filling tool to manually select
and fill holes (more info: ->).

If you have any further questions,
please click on the Ask? button.


>Buff


- Click on the Polish tool.




- Then click on the Buff tool.



>Note: When buffing, please make sure that the model is a fused or merged
model.

- Select localized data to smooth or all for the entire mesh.
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Selected data will be

b>3. Enter the desired buff options:



>Results



Before
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After


If you have any further questions, please click on the Ask? button.


>Simplify

>Note: When using the Simplify tool, please make sure that you are working
on a fused or merged model. Simplifying prior to fusing/merging will create
non-uniform mesh.  Please regenerate scans if you need to decrease model size
before fusing (more info -> ). 


- Click on the Polish tool.




- Click on the Simplify tool.




- Select the local data to simplify or select all.




- Choose the desired simplification tolerance from the top menu bar slider.




- Click the SIMPLIFY button.
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Before Simplify

After Simplify


If you have further questions on the simplify tool, please click on the Ask?
button.


>Remesh


- Ensure that meregd or fused model is in the green section of the bottom
view bar



>Note: It is advised to remesh scans that have been merged/fused. For more
info: ->.

- Select the Remesh tool from the Advanced Polish Menu.
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Choose Remesh Settings

>Fill Holes: Select the Hole Filling Settings to fill some or all holes.



>Keep Holes Larger Than: If you don't want to fill all holes, then you
can manaully set which holes of circumference size to fill.

The Remesh tool
can be very useful when run after Merging Scans to create a water-tight
mesh.  


If you have any further questions, please click on the Ask?
button.


>Clean Defects

>Clean Defects should be run at the end of your polishing process and can be
used to automatically eliminate any self intersecting or non-manifold
triangles.

To Clean Defects in your mesh:

1. Ensure that your Merged
and Remeshed model or fused model is in the green section of the bottom view
bar.




2. Select "Clean Defects" from the Polish - Advanced menu.




Any defects in the mesh will be automatically detected and cleaned.

If you
have any further questions, please click on the Ask? button.
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3.8  Orient




The Orient Tool can be used to define an origin and Orient your scan data
in a defined global coordinate space.

- Click on the CAD button from the
top toolbar to enter the CAD toolbar:




- Select Orient to enter the Orient toolbar:




- ScanStudio will show a bounding box representation of the common view
planes (top, left, front, etc.):



>Settings



>Base
- Click the base button and place 3 pins on the object to define one
of the common view planes of the bounding box:



>Faces
- Click on faces to view the front, back, left, right, top and
bottom locations
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>Origin
- Click on the origin button and place 1 pin on the mesh to define
the origin.

Notes: Mesh scan data can be globally oriented, but CAD data
cannot.
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3.9  Measure



>Volume Measurement

- Ensure that your fused or merged and remeshed data
is in the green section of the bottom view bar.
- Select Volume from the
Measure menu:




- The calculated volume will be displayed:



Surface Area Measurement

- Ensure that your fused or merged and remeshed
data is in the green section of the bottom view bar.
- Select Surface Area
from the Measure menu:




- The calculated surface area will be displayed:



>Point to Point Measurement 

- To measure a distance on a scan you can
click on one point then press the letter "i" on your keyboard. 
- This will
give you the coordinates of that point. 
- Then do the same at your second
point and it will give you the new coordinates along with the distance to the
previous point.
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3.10  Output




- Click the OUTPUT button to ouput the scan model.




-Choose the type of file you want to output




You can also export through the File-> Save As option.



>Mesh Files



b>IGES and STEP Files

- Exporting IGES and STEP files is only available
with ScanStudio CadTools. 

- For more information about upgrading to
CadTools please contact info@nextengine.com.

- Mesh data cannot be exported
as an IGES/STEP file.

- Insure the model contains either splines or
autosurfaces in the green section of the toolbar (for more info click here -
>).



Select
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Name your scan, choose the ouput

>Rapidworks

- Directly transfer a fused or unfused model from ScanStudio to
Rapidworks. 
- Surfaces and Splines cannot be transferred.



Select Rapidworks


- Output your currently loaded model as is.



b>U3D

- Due to our shift to a 64 bit platform we no longer support
the U3D file format. 
- ScanStudio 1.1.1 is still available for download
and it does have the option to export U3D files.
- Download it at this
link: ->
- If Adobe updates the U3D file format we will reimplement it in
future ScanStudio versions. 

For more information on using your scan data in
Solidworks click here ->.
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Chapter 4



 ScanStudio HD Add-Ons
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4.1  MultiDrive



>Intro

>New MultiDrive Platform for HD Scanner



360 360 360

b>Overview

-Automates alignment of multiple scan families



Up To 5 Scan Families Can Be

Existing 360 Rotation

Example 



Click the SCAN

Define Rotation, Tilt,


-START scan and model will be ready for TRIM, FUSE and POLISH


>Setup


-Here are the items that are included with the MultiDrive:



Allen wrench L Bracket AutoPostioner
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-Attach the L Bracket to the MultiDrive with two flat head screws and allen
wrench




-Attach the MultiDrive to the bottom of the scanner and fasten a screw
underneath the scanner for additional stability




-Plug in the MultiDrive to the scanner




-Start ScanStudioHD and proceed to Calibration


>Calibration

>MultiDrive Calibration



Manual MultiDrive Calibration
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-You can also use the drop down menu of Align, Calibrate MultiDrive to
run a calibration sequence.
-An object should be mounted on the MultiDrive,
we recommend using the palm tree included with the scanner.
-This function is
available for re-calibration when alignment results in an error or when the
MultiDrive was detached and is reattached.


>Scan Process


After calibration is

A new scan panel will be


-Five families are now available for predefined settings for Positioning,
Divisions, Start Angle, Tilt Angle, Points/IN^2 and Target 
-Clicking on
the family name will enable the tab to edit the settings.
-To enable or
disable a family, simply check or uncheck the circle next to the family
name.
-Starting positions can be set for both the initial and tilt axis by
moving the slider bar arrow.
-The start axis has the full 360 rotation and
tilt axis is bounded to -35 to 45 degrees.
-Use the top slider bars to
visually set the starting and tilt positions. (This will update the settings for
the scan family)




-Select the scan settings for each tab and check the tabs you want to have
scan. 
If the setting for a tab have been adjusted, but the tab is not
checked it will not scan.
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-All MultiDrive scans are to be in MACRO mode.
-Select a ROI for your
model to prevent the MultiDrive from being scanned in for certain tilt angles.
-
If additional scans are needed, enter scan panel and position the model by
using different starting and tilt angles to capture additional scans. 
-If you
physically adjust the part, then a 3 pin alignment will be needed to align.
-
When finished, trim unnecessary data and "Fuse" or "Volume Merge" the
model for export: ->


>Troubleshooting

b>Switching between AutoDrive and MultiDrive 
- Simply plug in an AutoDrive
to display the proper UI. 
- When reattaching the MultiDrive, make sure to
recalibrate as needed.

- When more than 5 Scan families are required, then
just click on scan to enter the scan panel, and you can add 5 more new
sessions. These scans should auto align to the previous scans assuming all the
movement and rotations were done by the turntable. If they don't auto-align
, just drag the scans into the green and refine (no pins required)

- Force
Calibration. If your scans are not coming in aligned, you may need to run a
force calibration. You can do this from the drop down menu , Align, then
go down to Calibrate MultiDrive


>Dental



Dental Cast Workflow with MultiDrive Download: Click Here

-This file and
other workflows are available under Help > What's New > Workflow
Documents on the left-hand side INDEX
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4.2  QA-Scan
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4.3  HD PRO




>To purchase the HD PRO license visit the buy page here. 
This software
requires an HD capable scanner. For more information click the ASK button
below.
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4.4  CAD Tools



>Intro


To purchase the CAD TOOLS license visit the buy page here. 
For more
information click the ASK button below.


>Spline


The Spline Tool can be used to extract boundary curves from your mesh
data.

- Ensure that the Fused mesh data that you wish to convert to
splines is in the green section of the bottom view bar.



Select CAD

Select SPLINE


- ScanStudio will automatically calculate and display a bounding box which can
be used to define the plane cuts to use to extract the boundary splines:



AXIS button to change which
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SPACING slider to control how

 The BOUNDS tool to control

ORIENT tool to position the


Use the Rotate tools to move either the mesh data, the bounding box, or
both.
     The Constrain tools can be used to limit rotation along a
particular axis.
     The Base tool can be used to define one of the
planes in the bounding box by placing pins on the mesh



Click SPLINE to complete


The set of splines created will be added to a common "Spline" family off
of the root of the model.
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>AutoSurface


The AutoSurface Tool will automatically create a patch network of surfaes from
the mesh model. This can be easily exported as an IGES or STEP file.

-
Ensure that you have merged results in the green section of the bottom view
bar:



Select CAD

Select

Choose the Number of


More surfaces may result in more accuracy.
     If the resulting surfaces
have missing data then try increasing the number of surfaces.



Click SURFACE


-The resulting surfaces are stored in the SCN file and displayed
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>Output


- Exporting IGES and STEP files is only available with ScanStudio CAD
TOOLS. 

- For more information about upgrading to CadTools please contact
info@nextengine.com.

- Mesh data cannot be exported as an IGES/STEP
file.

- Insure the model contains either splines or autosurfaces in the green
section of the toolbar



Select Output

Select

Alternate
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Name your scan, choose the ouput
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4.5  ProCare




To purchase the ScanStudio HD ProCare visit the buy page here. 
For more
information click the ASK button below.
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Chapter 5



 RapidWorks
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5.1  Getting Started
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5.2  Mesh Cleanup and Autosurfacing
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5.3  Solid Modeling
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5.4  Surface Modeling
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5.5  Hybrid Modeling
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5.6  RapidWorks 3.5.0 Tutorials



>Mesh Optimization

>Mesh Optimization Tutorial

This tutorial covers the workflow in creating a
watertight mesh model using powerful mesh modeling tools. You will learn about
the mesh modeling methods that can create a watertight mesh model from a set
of 3D scan data.



>Important Note: This tutorial is designed to be done using the Expert Mode
UI. To learn how to change RapidWorks to the Expert Mode UI, download
the instruction guide here:  Download


>Auto Surfacing

>Auto Surfacing Tutorial

This tutorial covers the workflow on how to
completely design a freeform part using powerful surface modeling methods. You
will learn surface modeling methods that can be used to create a freeform body
from 3D scan data.



b>Important Note: This tutorial is designed to be done using the Expert Mode
UI. To learn how to change RapidWorks to the Expert Mode UI, download
the instruction guide here:  Download


>Hybrid Design

>Hybrid Modeling Tutorial

This tutorial covers the workflow on how to
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completely design an industrial part by using powerful solid modeling methods.
You will learn modeling methods that can be used to create a solid body from
3D scan data. You will also learn how to transfer the fully designed model
to a dedicated CAD program.



b>Important Note: This tutorial is designed to be done using the Expert Mode
UI. To learn how to change RapidWorks to the Expert Mode UI, download
the instruction guide here:  Download
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5.7  ProCare




b>RapidWorks ProCare Pricing
- Within 90 days of RapidWorks purchase =
$995
- 90 days - 1 year = $1490
- 1 year - 2 years =
$1985
- 2 years - 3 years = $2480
- After 3 years =
$2975

Rapidworks ProCare can be purchased at 
https://www.nextengine.com/store
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Chapter 6



 QA Scan
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Chapter 7



 QA-Scan
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Chapter 8



 Other 3D Programs
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8.1  SolidWorks




b>-Other Solidworks Versions (Standard/Professional)
If you do not have the
Premium version and the Scanto3D Add-In you can use ScanStudio CAD
TOOLS -> to create surfaces or spines from your scan data, and then export
the surfaces or splines as  IGES or STEP. 
You can also use RapidWorks -
> , which allows the user to recreate a Solid Model from the Scan data,
then export a fully featured part into SolidWorks native SLDPRT file format.
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8.2  RapidForm XO




b>Rapidform XOR2

-Go to Insert - Import and under the dropdown for file
type select NextEngine files (*.scn):
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8.3  Geomagic




>Geomagic Studio
"Transform 3D Scan Data into Accurate Digital Models.
Designed to handle the most demanding reverse engineering, product design and
rapid prototyping challenges, Geomagic Studio transforms 3D scan data and
polygon meshes into accurate 3D digital models. A perfect complement to the
CAD, CAE and CAM tools you already own, Studio outputs industry standard
formats including STL, IGES, STEP and native CAD files."
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8.4  ArtCAM




http://www.artcam.com/


Here is a great new Forum from users
combining the NextEngine 3D Scanner and
ArtCAM:
http://forum.artcam.com/viewtopic.php?f=5&t=8143
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8.5  Mesh Lab




http://meshlab.sourceforge.net/

"MeshLab is an open source, portable, and
extensible system for the processing and editing of unstructured 3D triangular
meshes.
The system is aimed to help the processing of the typical not-so-
small unstructured models arising in 3D scanning, providing a set of tools for
editing, cleaning, healing, inspecting, rendering and converting this kind of
meshes."


Imports all mesh files; STL, OBJ, PLY, XYZ, VRML -
>
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8.6  Magics




http://www.materialise.com/materialise/view/en/2408555-Magics.html

-
Software for the Rapid Prototyping and Manufacturing Professional.

- Import
VRML, STEP and IGES files from ScanStudio HD and ScanStudio CAD Tools
into Magics.



94 of 140



8.7  Maya




http://usa.autodesk.com/adsk/servlet/pc/index?siteID=123112&id=135778
97
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8.8  MudBox




b>-Select 'Open a File...'



>-OBJ File Loaded into Mudbox



>-Using the sculpting tools you can quickly redesign your model
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8.9  ZBrush




>To Load your scan model in ZBrush you will need to export your model as
a STL or OBJ file ->
After opening Software Select Open Model (STL or
OBJ)




Select the STL/OBJ file from the directory and the model will load in the
app:
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8.10  Blender




>http://www.blender.org/download/get-blender/
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8.11  AutoDesk




You can now import IGS files by installing Parasolid Plug-In on the Autodesk
Labs site.

Here is the link :
http://labs.autodesk.com/utilities/translator_add-ins_for_autodesk_/

You can
access the translator using the standard Open command in Inventor.  You can
choose various file types to open and in this case I chose IGES as the file
type.  Once a file is selected you can choose the Options button on the
Open dialog.  For IGES files youll get the dialog below.




If it is water tight it will result in a solid as seen below.




If the objects have holes they will import in as surfaces.  The result ended
up in Inventors Construction environment with the idea that you can use the
tools there to clean up the model and import it into Inventors parameter
environment as either a solid or as a surface.  The picture below shows the
Blackberry in the construction environment.
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8.12  Rhino




>http://download.mcneel.com/download.asp?id=STLRepair
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8.13  Mathematica




b>STL model loaded as 3D Graphic in Mathematica
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8.14  3D Studio Max




>OBJ Scan Model Loaded in 3D Studio Max
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Chapter 9



 Reference
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9.1  User License Agreement



>NEXTENGINE, INC. SOFTWARE LICENSE AGREEMENT 3D DESKTOP
SCANNER AND SCANSTUDIO SOFTWARE PRODUCTS

These license terms are
an agreement between you and NextEngine, Inc. Please read them. They apply
to the software that accompanies these license terms, which includes the media
on which you received it, if any, your 3D Desktop Scanner device, and
accessories. The terms also apply to any NextEngine updates, supplements,
Internet-based services, and support services for this software and the
accompanying licensed device, unless other terms accompany those items. If so,
those terms apply.

BY CLICKING ON THE AGREE BUTTON BELOW,
YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT,
UNDERSTAND IT, AND AGREE TO THESE TERMS. IF YOU DO NOT
ACCEPT THE TERMS, NEXTENGINE DOES NOT LICENSE THE SOFTWARE
TO YOU, AND YOU SHOULD CLICK ON THE "DON'T AGREE"
BUTTON BELOW TO DISCONTINUE THE INSTALLATION PROCESS.

AS
DESCRIBED BELOW, USING THE SOFTWARE ALSO OPERATES AS YOUR
CONSENT TO THE TRANSMISSION OF CERTAIN COMPUTER INFORMATION
DURING ACTIVATION, VALIDATION, AND FOR INTERNET-BASED
SERVICES. 
IF YOU COMPLY WITH THESE LICENSE TERMS, YOU
HAVE THE RIGHTS BELOW FOR EACH LICENSE YOU ACQUIRE. 


1.
OVERVIEW.

This software package contains multiple products (e.g.
ScanStudio CORE, ScanStudio HD, ScanStudio HD PRO, ScanStudio CAD
Tools, etc.), each of which is separately purchased and activated.  These
products are licensed for nodelocked use from a single installation, as defined
by this license agreement.  For the avoidance of doubt, the products in this
software package must be installed onto the same computer, and the individual
products cannot be split up and installed onto separate computers.


 2.
INSTALLATION, LICENSING REQUIREMENTS, AND USE RIGHTS.

a.
Software Installation.
The software license is permanently assigned to the 3D
Desktop Scanner device with which you acquired the software. That device is
the licensed device.  You may install and use the software only from a single
computer that is owned and controlled by you.

b. Acceptable Use.
You
agree to install, maintain, and use the software according to the documentation
supplied by NextEngine; to follow NextEngine's instructions for installing updates
and upgrades and for correcting and circumventing bugs; and to abide by all of
the terms of this license agreement.

c. Term and Termination.
This license
agreement is effective until terminated. You may terminate it at any time by
destroying all copies and portions of the software and documentation. It will
also terminate immediately if you fail to comply with any term or condition of
this license agreement. Upon such termination, you agree to destroy all copies
and portions of the software and documentation.

d. Separation of
Components.
The components of the software are licensed as a single unit.
You may not separate the components and install them on different devices.


e. Remote Access.
The single primary user of the licensed device may
access and use the software remotely from the computer. You may allow other
users to access the software to provide you with support services. You do not
need additional licenses for this access. No other person may use the software
under the same license at the same time for any other purpose.

f. Sample
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and Tutorial Files.
You may copy and use the sample and tutorial files
provided with the software for your own personal training purposes only, unless
permission is otherwise granted in writing by NextEngine. 

g. Trial and
Conversion.
Some or all of the software may be licensed on a trial basis.
Your rights to use trial software are limited to the trial period. The trial
software and length of the trial period are set forth during the activation
process. You may have the option to convert your trial rights to perpetual
rights. Conversion options may be presented to you at the expiration of your
trial period. After the expiration of any trial period without conversion, most
features of the trial software will stop running.

h. Development Tools.
The
software may contain a software development kit (SDK), including code
libraries and development tools. You may only use this SDK to design,
develop, test, use, and demonstrate your programs with the software.

i.
Pricing and Payment.
Fees for the license granted hereunder shall be due before
licensing unless otherwise negotiated with NextEngine.  The effectiveness of the
licenses granted hereunder is conditioned on the receipt by NextEngine of all
applicable fees. 


3. SOFTWARE ACTIVATION.

Activation associates the
use of the software with you, a specific licensed device, and with a specific
computer. During activation, the software may send information about the
software, licensed device, user, and computer to NextEngine. This information
includes the version, language and the product ID of the software, Internet
protocol address of the computer, and information derived from the hardware
configuration of the device. By using the software, you consent to the
transmission of this information. Some changes to your computer components or
the software may require you to reactivate the software.

The software may
verify from time to time that it has been activated and properly licensed.
During a validation check, the software may send information about the
software, licensed device, user, and computer to NextEngine. BY USING THE
SOFTWARE, YOU CONSENT TO THE TRANSMISSION OF THIS
INFORMATION. If the software is not properly licensed, the functionality of
the software may be affected. For example, you may need to reactivate the
software, or receive reminders to obtain a properly licensed copy of the
software, or not obtain certain updates, upgrades or services from
NextEngine.


4. COMPLIANCE WITH LICENSES.

If you are a business
or organization, you agree that: 

a. Upon request from NextEngine or
NextEngine's authorized representative, you will  document and certify within
thirty (30) days that your use of NextEngine software at the time of the
request is in conformity with your licenses granted by NextEngine. 

b.
NextEngine may, at its expense, direct a recognized independent accounting firm
to audit, during normal business hours, the number of persons using the
software. Representatives of the auditing firm shall protect the confidentiality of
your information and abide by your reasonable security regulations while on your
premises. If your use exceeds the terms of this license agreement, then you
will be invoiced for any additional license fees necessary to bring you into
compliance. This invoice shall be payable within fifteen (15) days of
delivery. If the amount of such invoice is greater than five percent (5%) of
the aggregate amount of all license fees paid or payable by you to the date of
the audit, you will pay all expenses associated with such audit. 


5.
INTERNET-BASED SERVICES.

NextEngine may provide Internet-based services
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with the software, and NextEngine may change or cancel these services at any
time. These software features connect to NextEngine or service provider computer
systems over the Internet and may transmit information pertaining to your
computer, licensed device, software, usage, user, software errors, and bugs.
BY USING THE SOFTWARE, YOU CONSENT TO THE USE OF THESE
SERVICES AND TRANSMISSION OF THIS INFORMATION.

You may not use
these services in any way that could harm them or impair anyone elses use of
them. You may not use the services to try to gain unauthorized access to any
service, data, account or network by any means. 


6. SCOPE OF
LICENSE.

The software is licensed, not sold. This agreement only gives
you some rights to use the software. NextEngine reserves all other
rights.

Title, ownership rights, and intellectual property rights (including
without limitation all applicable rights to patents, copyrights, trademarks and
trade secrets inherent therein and appurtenant thereto) in and to the software
(including without limitation any images, data, animations, video, audio,
music, and text incorporated into the software), and all copies of the
software, are owned by NextEngine and/or its licensor(s), as applicable, and
are protected by U.S. copyright laws and international copyright treaties, as
well as other intellectual property laws, treaties, and federal and state trade
secret laws. Nothing in this license agreement constitutes a waiver of
NextEngine's rights under U.S. or international copyright law or any other
federal or state law.

Unless applicable law gives you more rights despite this
limitation, you may use the software only as expressly permitted in this
agreement. In doing so, you must comply with any technical limitations in the
software that only allow you to use it in certain ways. For more information,
see the software documentation. 
You may not:
work around any technical
limitations in the software; reverse engineer, decompile, disassemble, or reduce
the software to human-perceivable form, except and only to the extent that
applicable law expressly permits, despite this limitation; modify, adapt,
translate, or create derivative works except as authorized by the documentation;
remove any proprietary notices or labels on the software, make more copies of
the software than specified in this agreement or allowed by applicable law,
despite this limitation; publish the software for others to copy; use the software
in any way that is against the law; rent, lease, lend, sublicense, or
otherwise transfer any or all of the software or rights granted by this license
agreement except as expressly provided herein; or use the software for
commercial online services, service bureau, or time-share services to third
parties without NextEngine's prior written consent, which may be withheld or
denied in NextEngine's sole and absolute discretion, and is subject to payment
of such additional license fees as NextEngine may require.


7. DERIVATIVE
WORKS.

You agree that NextEngine owns all rights, title, and interest in
and to any changes or suggested changes made by you to the software, and
you agree to execute any and all assignments or other documents necessary to
convey such ownership rights to NextEngine.


8. BACKUP COPY.

You
may make one backup copy of the software media and use it only to reinstall
the software. 


9. DOCUMENTATION.

Any person that has valid access
to your computer or internal network may copy and use the documentation for
your internal, reference purposes. 


10. TRANSFER TO A THIRD
PARTY.

You may transfer the software directly to a third party only with
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the licensed device and this agreement. Before the transfer, that party must
agree that this agreement applies to the transfer and use of the software. You
may not retain any copies.

All software licenses are bound to the licensed
device.  Sale of the licensed device automatically conveys all software licenses
associated with the device to the new device owner.  You may not sell the
software products separately from the licensed device.


11. UPGRADE OR
CONVERSION.

To upgrade or convert software, you must first be licensed
for the software that is eligible for the upgrade or conversion. Upon upgrade or
conversion, this agreement takes the place of the agreement for the software you
upgraded or converted from. After you upgrade or convert, you may no longer
use the earlier version of the software you upgraded or converted from.

Minor
software updates and bug fixes may be available at no cost, while major
software upgrades may require purchase. You may only obtain updates or
upgrades for the software from NextEngine or authorized sources.


12.
EXPORT RESTRICTIONS AND LEVIES.

The software is subject to United
States export laws and regulations. You must comply with all domestic and
international export laws and regulations that apply to the licensed device and
associated software. These laws include restrictions on destinations, end users,
and end use.
You are responsible for obtaining all required government
authorizations to purchase and use the licensed device and software, including,
without limitation, any export or import licenses and foreign exchange permits.
NextEngine shall not be liable if any such authorizations are delayed, denied,
revoked, restricted, or not renewed, and you shall bear all risks and costs
associated with such activities.
If you are importing or exporting the Software
outside of the United States, you agree to indemnify and hold NextEngine
harmless from and against any import and export duties or other claims arising
from such importation or exportation. You shall be responsible for payment of
all taxes, fees, assessments, or levies on the software, or arising out of or
imposed by reason of this agreement or the license granted hereunder, except for
any tax based on NextEngine's annual net income.
13. SUPPORT
SERVICES.

NextEngine provides online and phone support within the first
twelve (12) months of the original purchase of your licensed device and
software products from NextEngine.  This support is non-transferrable and
immediately terminated if the licensed device is resold by the original owner. 
Additional support options may be available for purchase from NextEngine. 
Contact NextEngine for additional information.


14. GOVERNMENT END
USERS.

The license granted under this License Agreement does not constitute
a response by NextEngine to any request for proposals, bid solicitation or other
invitation or offer to contract by any governmental authority but instead constitutes
an offer to enter into a license agreement only upon the terms and conditions
set forth herein. If the United States Government or any other governmental
authority shall seek to acquire the Software and its acquisition of such Software
would result in the U.S. Government or such other governmental authority
having rights in any software that are at variance with the terms and conditions
of this License Agreement, NextEngine shall not be bound by any such rights
unless it shall have expressly entered into an amendment of this License
Agreement that shall set forth such rights in accordance with any applicable
governmental rules or regulations, including the Federal Acquisition Regulation and
the Defense Federal Acquisition Regulation Supplement. The Software is a
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"commercial item," as that term is defined in 48 C.F.R. 2.101.
The contractor/manufacturer is NextEngine, Inc., 401 Wilshire Boulevard,
Ninth Floor, Santa Monica, CA 90401.


15. ENTIRE
AGREEMENT.

This agreement (including the warranty below), any addendum
or amendment included with the software, and the terms for supplements,
updates, Internet-based services and support services that you use, are the
entire agreement for the software and support services and supersedes all previous
and contemporaneous communications, presentations, quotations, or agreements
regarding the subject matter hereof.

No waiver, alteration, modification, or
cancellation of any of the provisions of this license agreement shall be binding
unless made in writing and signed by an authorized officer of NextEngine.



16. APPLICABLE LAW.

This license agreement is governed by the
laws of the State of California without regard to its conflict of laws principles.
You consent to the jurisdiction and venue in the state and federal courts sitting
in Los Angeles, California. 


17. SURVIVAL.

The obligations of
confidentiality and indemnification and other restrictions contained in this license
agreement, but not the license to use the software, shall survive the termination
of this license agreement.


18. EQUITABLE RELIEF.

You agree that
NextEngine shall be entitled to obtain injunctive relief against you, in addition
to any other remedies to which it may be entitled, to enforce the terms and
conditions of this license agreement and to protect NextEngine's proprietary rights
in the software.


19. WAIVER.

No failure or delay on the part of
any party in exercising any right or remedy provided in this license agreement
shall operate as a waiver thereof; nor shall any single or partial exercise of or
failure to exercise any such right or remedy preclude any other or further
exercise thereof or the exercise of any other right or remedy under this license
agreement.


20. SEVERABILITY.

If any provision of this license
agreement is held by a court of competent jurisdiction to be illegal, invalid or
unenforceable, the remaining provisions shall remain in full force and
effect.


21. LEGAL EFFECT.

This agreement describes certain legal
rights. You may have other rights under the laws of your state or country.
You may also have rights with respect to the party from whom you acquired
the software. This agreement does not change your rights under the laws of
your state or country if the laws of your state or country do not permit it to
do so. 


22. INDEMNIFICATION.

You agree to hold harmless,
indemnify, and defend NextEngine, its officers, directors, employees, and
agents, from and against any loss, claim, or damages (including reasonable
attorneys' fees) arising out of or relating to any claim:
that you have
encoded, compressed, copied, or transmitted any materials (other than the
materials provided by NextEngine) in connection with the software; that you
have used the software in violation of another party's rights or in violation of
any law; that you have misused, allowed to be misused or modified the
software in any manner not expressly permitted by this license agreement; or
that any content added to or incorporated into the software by you infringes any
intellectual property rights of any third party.


23. HEADINGS.

The
headings in this license agreement are for purposes of reference only and shall
not in any way limit or affect the meaning or interpretation of any of the
terms hereof. 


24. LIMITATION OF LIABILITY.

IN NO EVENT
WILL NEXTENGINE BE LIABLE FOR ANY INDIRECT, SPECIAL,
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INCIDENTAL, CONSEQUENTIAL OR PUNITIVE DAMAGES, OR ANY
DAMAGES RELATED TO LOSS OF USE, DATA, SOFTWARE, BUSINESS,
PROFITS OR GOODWILL, WORK STOPPAGE, OR ANY OTHER
COMMERCIAL DAMAGES OR LOSSES, ARISING IN CONTRACT, TORT OR
OTHERWISE, EVEN IF NEXTENGINE HAS KNOWLEDGE OF THE
POTENTIAL LOSS OR DAMAGE. NEXTENGINE SHALL NOT BE LIABLE
FOR DAMAGES, CLAIMS BY THIRD PARTIES OR ANY OTHER CLAIM
FOR ANY CAUSE WHATSOEVER, REGARDLESS OF THE FORM OF
ACTION, ARISING MORE THAN ONE (1) YEAR AFTER THE
DISCOVERY OF THE DEFECT RESULTING IN ANY SUCH DAMAGE. YOU
ACCEPT THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT
WITH THE UNDERSTANDING THAT NEXTENGINE'S LIABILITY IS
LIMITED, THE FEES PAYABLE HEREUNDER HAVE BEEN AND WILL BE
CALCULATED ACCORDINGLY, AND THAT YOU MAY REDUCE YOUR RISK
FURTHER BY MAKING APPROPRIATE PROVISION FOR INSURANCE. YOU
FURTHER AGREE TO MITIGATE ALL LOSSES OR DAMAGES.


NextEngines total liability to you for actual damages for any cause whatsoever
will be limited to the greater of $500 or the amount paid by you for the
software that caused such damage.

This limitation applies to anything related to
the software, services, content (including code) on third party Internet sites,
or third party programs; and 
claims for breach of contract, breach of
warranty, guarantee or condition, strict liability, negligence, or other tort to
the extent permitted by applicable law. 

It also applies even if repair,
replacement or a refund for the software does not fully compensate you for any
losses; or 
the manufacturer or installer, or NextEngine knew or should have
known about the possibility of the damages. 

Some states do not allow the
exclusion or limitation of incidental or consequential damages, so the above
limitation or exclusion may not apply to you. They also may not apply to you
because your country may not allow the exclusion or limitation of incidental,
consequential or other damages. 


LIMITED WARRANTY 

A. LIMITED
WARRANTY.

If you follow the instructions, the software will perform
substantially as described in the NextEngine materials that you receive in or with
the software. 


B. TERM OF WARRANTY; WARRANTY RECIPIENT;
LENGTH OF ANY IMPLIED WARRANTIES.

THE LIMITED WARRANTY
COVERS THE SOFTWARE FOR 30 DAYS AFTER ACQUIRED BY THE
FIRST USER. If you transfer the software, the remainder of the warranty will
apply to the recipient.

TO THE EXTENT PERMITTED BY LAW, ANY
IMPLIED WARRANTIES, GUARANTEES OR CONDITIONS LAST ONLY
DURING THE TERM OF THE LIMITED WARRANTY. Some states do not
allow limitations on how long an implied warranty lasts, so these limitations
may not apply to you. They also might not apply to you because some
countries may not allow limitations on how long an implied warranty, guarantee
or condition lasts. 


C. EXCLUSIONS FROM WARRANTY.

This warranty
does not cover problems caused by your acts (or failures to act), the acts
of others, or events beyond the reasonable control of the manufacturer or
installer, or NextEngine.

D. REMEDY FOR BREACH OF
WARRANTY.

NEXTENGINE WILL, AT ITS ELECTION, EITHER (I)
REPAIR OR REPLACE THE SOFTWARE AT NO CHARGE, OR (II)
REFUND THE AMOUNT PAID FOR THE PRODUCT, IF ANY. NEXTENGINE
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MAY ALSO REPAIR OR REPLACE SUPPLEMENTS, UPDATES, AND
REPLACEMENT SOFTWARE, OR PROVIDE A REFUND OF THE AMOUNT
YOU PAID FOR THEM, IF ANY. THESE ARE YOUR ONLY REMEDIES
FOR BREACH OF THE LIMITED WARRANTY. 


E. CONSUMER RIGHTS
NOT AFFECTED.

YOU MAY HAVE ADDITIONAL CONSUMER RIGHTS
UNDER YOUR LOCAL LAWS, WHICH THIS AGREEMENT CANNOT
CHANGE. 


F. WARRANTY PROCEDURES.

Contact NextEngine to find
out how to obtain warranty service for the software. For a refund, you must
comply with the NextEngines return policies. 


G. NO OTHER
WARRANTIES.

THE LIMITED WARRANTY IS THE ONLY DIRECT
WARRANTY FROM NEXTENGINE. NEXTENGINE GIVES NO OTHER EXPRESS
WARRANTIES, GUARANTEES OR CONDITIONS. WHERE ALLOWED BY
YOUR LOCAL LAWS, NEXTENGINE EXCLUDES IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-
INFRINGEMENT. If your local laws give you any implied warranties, guarantees
or conditions, despite this exclusion, your remedies are described in the remedy
for breach of warranty clause above, to the extent permitted by your local
laws. 


H. LIMITATION OF LIABILITY FOR BREACH OF
WARRANTY.

THE LIMITATION OF LIABILITY CLAUSE ABOVE APPLIES
TO BREACHES OF THIS LIMITED WARRANTY. 
THIS WARRANTY GIVES
YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER
RIGHTS WHICH VARY FROM STATE TO STATE. YOU MAY ALSO HAVE
OTHER RIGHTS WHICH VARY FROM COUNTRY TO COUNTRY.
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9.2  Customer Support
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9.2.1  RapidWorks Site License




The terms of RapidWorks EDU site licenses are as follows:
 
       
 Cost:  $10K

         20 licenses

         Site license
applies to individual school Departments (i.e. ME, Architecture, Archeology,
etc).

         Must purchase RapidWorks ProCare ($995), no
more than 2 support contacts.

         Pre-Pay required

Currently,
this is not available at nextengine.com/store, but quotes can be generated with
the site license included.
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9.2.2  Duplicate Scanner Purchase No Refund
Policy




When a customer purchases a product and then returns within the 30 to 45
day period, if they choose to repurchase the same product that was returned,
they are not eligible for the 30 day trial period.  

When such orders
occur, the customer will be contated to determine the reason for the
repurchase, and informed that they are not eligible for the 30 day money
back guarantee period.
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9.2.3  Scanner Repairs



>In Warranty

PartGripper Repair in Warranty:  If found to be broken by AE, send
replacement.


>Out Of Warranty

b>SD Scanners Repairs: No longer supported for repair, we do not have parts
with which to repair them.


>Warranty Support Questions

>8. Was the scanner opened and were any self repairs attempted (this is
mostly for out of warranty repairs)?

The last three questions in bold are
questions that are specific to out of warranty repairs and will help us make
sure that we are able to repair the damage within the $395 flat fee. The
first five questions are already part of what we are doing today, so please
continue to handle repairs as normal, but ask those three additional questions in
the end for questionable cases.

A 'Warranty Void' user has been created in
the NextWiki, please mark any user that has voided their warranty as a review
item to flag their account.
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9.2.4  Scanner Returns



>Stopping Returns Documentation

1.  Understand the customers needs and use
any utility possible to help them:
      A.  If speed is the issue, you
can offer trials of HD PRO and suggestions on how to improve their work-
flow.
      B.  If data quality is the problem, get their data and
make all possible improvements.
      C.  If the end goal seems
impossible from the software we offer, research other software that may help
them.

2.  Show we are committed to the customer getting a positive
result:  
     A.  Engaging the customer and going above and beyond
resonates well with them.
     B.  Extension of the 30 days is another
sign of good faith and at times can be the difference in a return (ask me
before offering this).
     C.  Offer to have them send in a part,
we'll scan it for them and provide the work-flow on how it was
done.

3.  This is a team effort:
     A.  Passing a potential return
to another AE provides the customer another voice that may help him/her
understand better.
     B.  Feel free to consult any or all of the AE's
with return questions or suggestions on possible solutions.

4.  Use the
phone or GoTo:
     A.  If the customer is struggling with chat or
email, call them or set up a GoTo.

5.  Let me know if a return is
imminent:
     A.  Once you have exasperated all other options, make
sure Michael is aware prior to sending out the email to
"returns@nextengine.com".

6.  Remember our updated return processing
policies:
     A.  The returns email should contain ALL pertinent info: 
User's Name, Email, Order #, Serial #, Address, Reason for return,
and any other notable information.
     B.  Once return email has been
sent, let the customer know that they need to package their scanner immediately
and they are to ship the scanner as soon as they receive their labels.
    
C.  After the returns email is sent, Scott will be disabling the users software
so they cannot use the scanner any longer.

Make sure to:

1. Find out
what their application is and what software they are using.  What is their end
goal?
2. What are their complaints / problems with the scanner?
3. Get
a copy of their scan data to work with.
4. Get them on the phone / Go
To, show commitment to getting them quality results.
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9.2.5  HD Exchange



Additional Information:
http://www.nextengine.com/products/hd-
technology#1
http://www.nextengine.com/products/hd-
technology#2
http://www.nextengine.com/products/hd-technology#3
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9.2.6  Second Hand Scanners



>Policy

>Second Hand Scanner Policy

*  New owner does not have to pay $295
to use the product and have software.
*  User can pay $295 (ScanStudio
HD ProCare) if they would like support, warranty and software updates.
* 
To purchase ScanStudio HD ProCare, the customer must call front desk to
complete the order. 1-310-883-1888.
*  When the purchase of
ScanStudio HD Pro Care is made, place as review item under Wiki User
"Resold Scanners".  Make sure to indicate both the original owner, and the
new owner's names for future reference and transfer the licenses accordingly.
*
 If it is an SD Scanner, note that it cannot be repaired, we no longer have
parts.
*  Promo Code for Resold Scanners would allow the customer to
complete the order without our assistance. (Currently being considered, but not
yet implemented.)


>Sample Response

>Sample Second Hand Scanner Response

For all second hand scanner purchases
a new account will be required for setup. This is done through the purchase
of ScanStudio HD ProCare ($295).

This will then provide your very own
account for the NextEngine 3D scanner and also includes:

   * Access to
Desktop 3D scanner support, tutorials and video
   * Live chat support from
7am - 6pm PST through our NextWiki
   * Software updates for
ScanStudioHD

For SD scanner users, it will include the same features above,
except it will provide access to the ScanStudio CORE software.

To get
started, please provide us with the following information

   * Name
  
* Email
   * Phone
   * Scanner serial number

Thank you, I look
forward to hearing back from you.
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9.2.7  Product Pricing & Shipping Rates



>Pricing

RapidWorks ProCare Pricing (Renewal after first 3 years of ProCare
expires):
Expiration date - 90 days = $995
90 days - 1 year =
$1,490
1 year - 2 years = $1,985
2 years - 3 years =
$2,480
After 3 years: $2975


>Domestic Shipping Rates

>United States
Scanner:
         Ground: $23
         Second-
Day: $43
         Next-Day: $63
AutoDrive:
        
Ground: $12
         Second-Day: $22
         Next-Day:
$32
MultiDrive:
         Ground: $8
         Second-Day:
$18
         Next-Day: $28
Curriculum: 
         Ground:
$7
         Second-Day: $12
         Next-Day: $26


>International Shipping Rates

NOTE: 
1. AutoDrive Shipping done by Scott on case-by-case basis.
2.
We do not split shipments.

*Albania, Belarus, Boznia-Herzegovima,
Bulgaria, Croatia, Czech Republic, Estonia, Hungary, Latvia, Lithuania,
Macedonia, Moldova, Montenegro, Poland, Romania, Serbia, Slovakia,
Slovenia, Ukraine.


>Countries Not Serviced

>Countries not serviced by FedEx:  

Andorra
Burma
Central African
Republic
Comoros
Cuba
Equatorial Guinea - GQ
Falklands
Guinea
Bissau
Iran
Johnston Island
Kiribati
Myanmar
Nauru
Niue
North Korea
Sao
Tome& Principe
St Helena (S. Atlantic)
Sierra Leone
Solomon
Islands
Somalia
Sudan
Tajikistan
Tokelau Island
Turkmenistan, Republic
of
Tuvalu
Wake Islands
Russia
Libya
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9.2.8  FTP Protocol



>FTP Login

>All Other FTPs
Username: sbsamples
Password: statue818

Username:
sarahb
Password: user

Username: sarah
Password: snickers

Username:
brad
Password: wolverines

Username: andres
Password: porsche

Username:
andrest
Password: porsche

Username: nick
Password: baseball

Username:
dang
Password: casper

Username: rapidworks
Password:
nextengine

Username: inus
Password: re4ne

Username: taylor
Password:
corvette

Username: builds
Password: scanstudio2


>Ways to Access


1. Download Filezilla (http://filezilla-project.org/) to upload / download
files.
2. Use Web Browser to go to ftp.nextengine.com.
3. Use Folder
Viewing Window on computer:

Open My Computer or any folder viewing
window:




In the Address bar, type in: ftp.nextengine.com:




Press enter and a window should come up asking for the username and
password:




Log on to access the FTP site
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9.2.9  Wiki Account Policies




Internal (Brad, Dan, Sales): 
          Create Prospect account
and create action item or notification to delete after trial is over.

External
(Resellers, Customers):
          Refer them back to the owner,
reseller or supplier for login information.

Multiple Scanners:
         
Create new account for scanner only if multiple scanners purchased.
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9.2.10  Common Support Instructions



>SS HD

Full Reinstall:

          1. Go to support.nextengine.com to
Downloads-> ScanStudio HD.  Download 32 or 64 bit scanstudio HD
1.3.2 depending on whether you have a 32 or 64 bit OS.  Save to
your desktop.

          2. Shut down ScanStudio.

        
 3. Run the uninstaller in the Start -> Programs -> NextEngine
folder.

          4. Delete the following folders:

         
C:\Program Data\NextEngine (for Vista/Win 7)
         
C:\Documents and Settings\All Users\Application Data\NextEngine (for XP)
 
        C:\Program Files\NextEngine
          C:\Program Files
(x86)\NextEngine
          note: make sure "show hidden folders"
is on for the Program Data folder to show up.

          5. 
(For Vista or Win 7) Go to Control Panel-> User Accounts.  In the
User Accounts, there should be a window with a small blue link to
change/turn off the User Account Controls (UAC).  Make sure the slider is
set down to the lowest level.

          6. Restart your computer. 
Make sure antivirus/firewall are down temporarily.

          7. Run
the installer from your desktop for the ScanStudio HD 1.3.2 you downloaded
with scanner unplugged. Make sure you install on the computer C: hard
drive.


>SS Core


Full Reinstall (XP / Vista)

          1. Uninstall any versions
of ScanStudio.

          2. Delete the following folders:

    
     C:\Documents and Settings\All Users\Application Data\NextEngine (for
XP)
          C:\ProgramData\NextEngine (for vista)
        
 C:\Program Files\NextEngine

          If those folders are not
visible, make sure your folder tools is set to "Show hidden folders".

  
       3. Go to www.nextengine.com/start and login.

        
 4. There should be a link that says "To download software for your SD
scanner, click here".  Click this link, download ScanStudio 1.7.3 and
install it without the scanner connected.  

          5. After
installation, plug scanner and verify that software and scanner work
effectively.

Full Reinstall (Windows 7 64 bit ONLY)

         
1. Make sure you have the installer for ScanStudio 1.7.3 on your
desktop.

          2. Shut down ScanStudio.

         
3. Run the uninstaller in the Start -> Programs -> NextEngine folder for
all versions that are installed.

          4. Delete the following
folders:

          C:\Program Data\NextEngine (for Vista/Win
7)
          C:\Documents and Settings\All Users\Application
Data\NextEngine (for XP)
          C:\Program Files\NextEngine
  
       C:\Program Files (x86)\NextEngine
          note:
make sure "show hidden folders" is on for the Program Data folder to show
up.

          5. (For Vista or Win 7) Go to Control Panel->
User Accounts. In the User Accounts, there should be a window with a small
blue link to Change/turn off the User Account Controls (UAC). Make sure
the slider is set down to the lowest level.

          6. Restart
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your computer. Make sure antivirus/firewall are off temporarily.

       
  7. Run the installer from your desktop for the ScanStudio 1.7.3 with
scanner unplugged. Make sure you install in the computer's C: hard drive as
an administrator. You can right click on the installer and select "Run as
administrator".

          8. Afterwards, use the driver installer on
the support.nextengine.com website to install the new win drivers.  It is in
the downloads section. Then, place the previous driver I posted/attached here
and place it in the locations:

          C:\Program Files
(x86)\NextEngine\ScanStudio\Driver
          C:\Program Files
(x86)\NextEngine\ScanStudio\dll

          (attach driver
wdapi901.dll)


>Login Info


Need to Match two out of three of the following in order to disclose login
information:

Name, Email, Company
Order Number
Scanner Serial
Number

Be sure to check in both the Order System and the Wiki.


>MultiDrive Calibration


How to reset the MultiDrive calibration:

1. Close ScanStudioHD
2. Go
to C:\ProgramData\NextEngine\ScanStudioHD\user.ini
3. Open User.ini
file.
3. Delete everything under "Secret" (line 4 or 6)
4. Save
user.ini file and close
5. Re-do calibration in ScanStudio.


>Text Cut Off


Win 7/Vista:

1. Go to Control Panel > Appearance and Personalization
> Display
2. Make sure that display / magnification is set to 100%
3.
Save changes and re-boot ScanStudio

XP:

1. Go to Control Panel >
Display.  This will bring up the Display Properties
2. In Settings Tab, click
on 'Advanced'
3. Make sure DPI is set to Normal Size (96dpii) and
apply changes.
4. Restart ScanStudio.


>3GB Switch


*For users who are running a x32 OS and more then 2GB of
Memory

http://www.microsoft.com/whdc/system/platform/server/PAE/PAEmem
.mspx  (Microsoft Documentation)

http://dwf.blogs.com/beyond_the_paper/2009/04/enabling-3gb-switch-
on-windows-vista.html  (Blog posting w/ more detail)
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9.2.11  QA Scan Licensing Statement



>Multiple Install Inquiry Response

Per our QA-Scan User License Agreement,
the activation key should only be used by the account holder and is not to be
distributed outside the initial purchasing company.  QA-Scan can be activated
on your office computers if more than one install is necessary.   Installs must
be kept to a minimum as we will be monitoring each install and account
activity.
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9.2.12  Top Bar Crash Support Procedure



Steps to Handle Top Bar Crash Cases:

1. Get LOG file for system
specs

2. Add to Top Bar Crash review action item

3. Suggest updating
graphics card drivers

4. Screenshot of crash

5. Provide workaround for
running in compatibility mode
        -Close ScanStudioHD
        -
Right click ScanStudioHD shortcut and go to Properties
        -Click on
the Compatibility tab
        -Check box "Run this program in
compatibility mode for"
        -Set to Vista SP2
        -Apply
and run ScanStudioHD

6. Notify them of current bug: 
        -Not
a common bug
        -Specific to Windows 7 64-bit computers with
Xeon or Core i7 processors with CAD graphics card (also have seen it occur
on higher end graphics cards)
        -Running in compatibility mode is
only workaround available, but results in slower trim times
        -
Developers are working on this issue (do not specify timeline)

7.
Recommend alternative graphics cards
        -ATI Radeon HD 4000
series
        -GeForce GTS 200, 300 400 series

8. Cards
we have seen hit this error
        -NVDIA Quadro series
       
-NVIDIA GTX series
        -NVIDIA GT 200M and 300M series

       -ATI FirePro series
        -ATI RadeonHD 5000 and
6000 series
        -SLI/Crossfire setup
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9.2.13  Shipping Templates



>Repair or Return

Scanner Return after Repair In / Out Warranty

Your scanner was repaired,
retested, and sent back to you today via FedEx, tracking #.  We once
again apologize for the inconvenience and please feel free to contact us if you
have any questions.

Best regards,


>Domestic

b>Domestic Scanner Repair Shipping Instructions

You should receive an email
shortly from EmailLabel@fedex.com which includes return labels and instructions to
send your non-working scanner back to NextEngine. (If you do not receive an
email please check your junk\spam folder). Once you receive the return
labels, please pack only the scanner in the original packaging and affix the
label to the outside of the box. You may then either call FedEx to schedule
a pickup at 1 800 463-3339 or find the nearest drop off location at
http://fedex.com/Dropoff/start. When we receive your scanner we will
attempt to rectify the problems you incurred or issue a working replacement to
you. We apologize for the inconvenience and please don't hesitate to contact
us if you have any questions.

Thanks and best regards,


>International

>IntÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚Æ’ÃƒÆ’Ã‚Æ’Ã
ƒâ€šÃ‚â€šÃƒÆ’Ã‚â€šÃƒâ€šÃ‚Æ’ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚Æ’Ãƒ
Æ’Ã‚â€šÃƒâ€šÃ‚â€šÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚â€šÃƒÆ’Ã‚â€šÃƒ
â€šÃ‚Æ’ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚Æ’ÃƒÆ’
Ã‚Æ’Ãƒâ€šÃ‚â€šÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â€šÃƒÆ’Ã‚Æ’Ãƒâ€š
Ã‚Æ’ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â€šÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚â€šÃƒÆ’Ã
‚â€šÃƒâ€šÃ‚Æ’ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚
Æ’ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚â€šÃƒÆ’Ã‚â€šÃƒâ€šÃ‚Æ’ÃƒÆ’Ã‚Æ’
Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â€šÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚â€š
ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â€šÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚â€šÃ
ƒâ€šÃ‚Æ’ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚â€šÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â€šÃ
ƒÆ’Ã‚Æ’Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â€šÃƒÆ’Ã‚Æ’Ãƒâ
€šÃ‚â€šÃƒÆ’Ã‚â€šÃƒâ€šÃ‚Â¢ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚Æ’ÃƒÆ’
Ã‚â€šÃƒâ€šÃ‚Æ’ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚â€šÃƒÆ’Ã‚â€šÃƒâ€š
Ã‚Æ’ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â€šÃƒÆ’Ã‚
Æ’Ãƒâ€šÃ‚â€šÃƒÆ’Ã‚â€šÃƒâ€šÃ‚Æ’ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚Æ
’ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚Æ’ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚â€šÃƒÆ’Ã‚â€š
Ãƒâ€šÃ‚â€šÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â€š
ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚â€šÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â€šÃƒÆ’Ã‚Æ’Ã
ƒâ€šÃ‚Æ’ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚Æ’ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚â€šÃƒ
Æ’Ã‚â€šÃƒâ€šÃ‚Æ’ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚â€šÃƒâ€
šÃ‚â€šÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚â€šÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â€šÃƒÆ
’Ã‚Æ’Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚Æ’ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ
‚â€šÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â€šÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚
â€šÃƒâ€šÃ‚â€šÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚â€šÃƒÆ’Ã‚â€šÃƒâ€šÃ
‚â‚¬ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚Æ’ÃƒÆ’Ã‚Æ
’Ãƒâ€šÃ‚â€šÃƒÆ’Ã‚â€šÃƒâ€šÃ‚Æ’ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚Æ’
ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â€šÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚â€šÃƒÆ’Ã‚â€š
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Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚Æ’Ãƒ
Æ’Ã‚Æ’Ãƒâ€šÃ‚â€šÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â€šÃƒÆ’Ã‚Æ’Ãƒâ
€šÃ‚Æ’ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â€šÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚â€šÃƒÆ
’Ã‚â€šÃƒâ€šÃ‚â€šÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚â€šÃƒâ€
šÃ‚Æ’ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚â€šÃƒÆ’Ã‚â€šÃƒâ€šÃ‚Æ’ÃƒÆ’Ã
‚Æ’Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â€šÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚
â€šÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â€šÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚â
€šÃƒâ€šÃ‚Æ’ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚â€šÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â
€šÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â€šÃƒÆ’Ã‚Æ’
Ãƒâ€šÃ‚â€šÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â„¢l Scanner Return Shipping
Instructions

A package with return labels and instructions to send your scanner
back to NextEngine was sent to you today via FedEx, tracking #. Once you
receive the return labels, please pack the scanner in the original packaging and
affix the label to the outside of the box. You may then either call FedEx to
schedule a pickup or find the nearest drop off location. When we receive the
scanner your refund will be processed and please don't hesitate to contact us if
you have any questions.

Thanks and best regards,


>SD to HD Scanner Exchange

>SD / HD Scanner Exchange

Thank you for your interest in the SD\HD
exchange program. To initiate the process, please send your SD scanner to


Returns Manager
401 Wilshire Blvd. 9th Floor
RMA#
Santa Monica,
CA 90401 USA

Upon return of the SD scanner, your new HD scanner
will be shipped. You'll receive an email with the tracking number and if you
have any questions please feel free to contact us at any time.

Thanks and
best regards,
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9.2.14  Accounting Policies



b>Tax ID Information

Forward all Tax ID inquiries to Jessica to review with
Kathy and determine if it is appropriate to disclose the ID.
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9.2.15  Stolen Scanners



>Case                       Order #              
 Scanner Serial #                 Email      

Canada    
              128236                  01 09
10 62022                   karoparisyan101@gmail.com   
                       
Canada                  
128614                  01 09 10 62319       
           drogba11aa@gmail.com                      
             
Canada                   132250   
              01 09 10 67698                 
 KINMAILKIN@YAHOO.COM                             

Canada                   132652                
 01 09 10 67555                  
MARCBREWER23@YAHOO.COM                     
Canada 
                 132718                  01
09 10 68369                  
CANADA007CANADA@GMAIL.COM               
Canada     
             132970                  01 09 10
68204                   CANADA007CANADA@GMAIL.COM
              
Canada                   133066  
               01 09 10 66796                
  GREIGJULES@YAHOO.COM                            
  
Canada                   133096              
   01 09 10 68600                   kartel@live.ca  
                                             
    
Canada                   133084            
     01 09 10 64541                  
COPERATIONXXL@GMAIL.COM                       
Canada
                  133420                  01
09 10 67280                  
KALIDORSASA@YAHOO.COM                         

Canada                   133456                
 01 09 10 65190                  
GAME5GAME@GMAIL.COM                            

Canada                   133468                
 01 09 10 65801                  
stone66cold@yahoo.com                                

Canada                   133486                
 01 09 10 64618                   jackds@live.ca    

US                           4626535         
     01 12 10 18120                  
mike.shipley2012@gmail.com
US                          
4619165               01 12 10 18219         
         andy.henderson@consultant.com
US                 
         4626975               01 12 10 16723
                  phyllis.eckersley@mail.com
US           
               4627503               03 13 01
15562                   phyllis.eckersley@mail.com
US     
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                     4635170               01
12 10 19979                   chris.clouet@aol.com
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9.2.15.1  
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9.2.16  RapidWorks Workarounds



>Non Admin Account Workaround


Instructions:

Install Microsoft Application Compatibility
Toolkit.

RunÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚Æ’ÃƒÆ
’Ã‚Æ’Ãƒâ€šÃ‚â€šÃƒÆ’Ã‚â€šÃƒâ€šÃ‚Æ’ÃƒÆ’Ã‚Æ’Ãƒâ€š
Ã‚Æ’ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â€šÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚â€šÃƒÆ’Ã
‚â€šÃƒâ€šÃ‚Æ’ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚
Æ’ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚â€šÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â€šÃƒÆ’Ã‚Æ
’Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â€šÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚â€
šÃƒÆ’Ã‚â€šÃƒâ€šÃ‚Æ’ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚â€šÃ
ƒâ€šÃ‚Æ’ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚â€šÃƒÆ’Ã‚â€šÃƒâ€šÃ‚Æ’Ãƒ
Æ’Ã‚Æ’Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â€šÃƒÆ’Ã‚Æ’Ãƒâ€
šÃ‚â€šÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â€šÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚Æ’ÃƒÆ’
Ã‚â€šÃƒâ€šÃ‚Æ’ÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚â€šÃƒÆ’Ã‚â€šÃƒâ€š
Ã‚â€šÃƒÆ’Ã‚Æ’Ãƒâ€šÃ‚Æ’ÃƒÆ’Ã‚â€šÃƒâ€šÃ‚â€šÃƒÆ’Ã
‚Æ’Ãƒâ€šÃ‚â€š 'C:\ProgramFiles\Microsoft Application Compatibility
Toolkit\Compatibility Administrator\Compatadmin.exe' as administrator:




Type name of program, vendor, and select program location:




Select 'RunAsInvoker' and click 'Next':
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Select 'No Virtualization' and click 'Next':




Leave defaults checked and click 'Finish':




Click 'Save', give database a name and then specify filename (such as
RapidWorksAdminFix.sbd)

Open command prompt as administrator, change
directory to location of file saved above and enter the command 'sdbinst.exe
RapidWorksAdminFix.sbd'.

RapidWorks should not launch without administrative
credentials.


>Left Docking Workaround


To clear out all the settings and return everything to default use the following
process:

1. Close RapidWorks
2. Go to C:\Program Files\INUS
Technology\RapidWorks
3. Run RegistryClean.bat
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9.3  Glossary



>Glossary of NextEngine Terms
Coming Soon
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9.4  Links



Other Links
Coming Soon
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